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 

SECTION – A (Remembering) 

Answer ALL the Questions: (10  1 = 10 Marks) 

1 The Postfix equivalent of the Prefix Notation * + ab - cd is 

 a) ab + cd - * b) abcd +-* c) ab+cd*- d) ab+-cd* 

CO2 

2 The data structure required to check whether an expression contains balanced parenthesis is? 

 a) queue b) stack c) linked list d) file 

CO2 

3 In a queue the deletion happens at the _______________ end. 

 a) front b) rear c) middle d) link 
CO3 

4 If FRONT = NULL then _________. 

 a) queue full b) queue empty c) dequeue d) priority queue 

CO3 

5 Which of the following is NOT a common operation in a queue data structure?  

 a) Enqueue b) Dequeue c) Peek d) Shuffle 
CO3 

6 Which of the following conditions correctly checks the underflow condition in a queue?  

 a) front = -1 b) rear = 1 c) rear = size d) front = 0 
CO3 

7 _____ a tree means processing it in such a way that each node is visited only once.              

 a) Traversing b) Implement c) Partition d) Node 

CO3 

8 The length of the path is the number of_____________ on the path. 

 a) nodes b) fields c) data d) edges 
CO3 

9 Which of the following is useful in traversing a given graph by Breath first search? 

 a) Stack b) Set c) List d) Queue 

CO4 

10 A tree is a data structure which represents hierarchical relationship between individual _________  

a) data items b) fields c) nodes d) linked list 
CO4 

 

SECTION – B (Remembering) 

Answer ALL the Questions: (5  2 = 10 Marks) 

11 Name the operations to add and remove a data element in a stack?  CO2 
12 Define Enqueue? CO3 

13 List the operations of queue ADT? CO3 
14 Define a leaf node in a tree data structure? CO3 

15 Define a Binary tree? CO4 
 

SECTION – C (Understanding)  

Answer ALL the Questions: (3  6 = 18 Marks) 

16 a) Write a note the operations of stack using an example?           (OR) CO2 

 b) Discuss on the characteristics of Queue ADT? CO2 
17 a) Differentiate between Enqueue and Dequeue?                         (OR) CO3 

 b) Brief the characteristics of circular queue? CO3 
18 a) Brief the characteristics of Tree data structure?                       (OR) CO3 

 b) Brief the characteristics of Tree data structure? CO3 
 

SECTION – D (Applying) 

Answer any ONE Question: (1  12 = 12 Marks) 

19 Explain in detail on the operations in Queue? CO3 

20 Enumerate on types of searching and working of bubble sort with neat diagram? CO4 
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SECTION – A (Remembering) 

Answer ALL the Questions: (10  1 = 10 Marks) 

1 EY0=____________ 

 a) Y-1 b) y0 c) y1 d) y2 

CO2 

2 _____________formulae used for equal interval 

 a) Newton forward b) Newton backward c) Guass forward and backward d) all 

CO2 

3 The forward difference operator denoted by the symbol is __________. 

 a) ∆ b) Ω c) ∂ d) ∞ 

CO3 

4 Newton forward interpolation formula, the first and second terms will give the ______ interpolation. 

 a) Linear. b) Parabolic. c) Hyperbolic. d) Non-linear. 

CO3 

5 The forward difference operator denoted by the symbol is __________. 

 a) delta b) nabla c) Omega d) beta 

CO3 

6 Trapezoidal rule is derived from ___________ formula. 

 a) Newton's cotes  b) Newton's forward interpolation 

 c) Newton's backward interpolation d) Inverse Lagrange's 

CO3 

7 The degree of y(x) in Trapezoidal Rule is _______. 

 a) 1 b) 2 c) 3 d) 6 

CO3 

8 Simpson's one third rule degree is ________. 

 a) one b) two c) 4 d) 6 

CO3 

9 What is the value of factorial Zero (0!)?  

 a) 0 b) 1 c) 2 d) 3 

CO4 

10 The order of the matrix B= [1 2 5 7] is ________. 

 a) 1*1 b) 1*2 c) 1*4 d) 1*3 

CO4 

 

SECTION – B (Remembering) 

Answer ALL the Questions: (5  2 = 10 Marks) 

11 Define Extrapolation  CO2 

12 Write about Newton divided difference interpolation  CO3 

13 Write a formula to find U and V   CO3 

14 Define Numerical integration  CO3 

15 Write a formula of Simpson’s  CO4 



 

 

 

SECTION – C (Understanding)  

Answer ALL the Questions: (3  6 = 18 Marks) 

16 a) use Lagrange’s formula to find the value of y at x=6 from the following data 

X 3 7 9 10 

y 168 120 72 63 

  

CO2 

 (OR)  

 b) Find f (10) using newton’s divided difference formula for the following data 

x 4 7 9 12 

y -43 83 327 1053 
 

CO2 

   

17 a) From the following data find x=43  

x 40 50 60 70 80 90 

y 184 204 26 25 276 304 

  

CO3 

 (OR)  

 b) the Population of town is as follows, Estimate the at following x=1976 

x 1941 1951 1961 1971 1981 1991 

y 20 24 29 36 46 51 

  

CO3 

18 a) write a procedure to solve Newton forward and Backward interpolation formula  CO3 

 (OR)  

 b) Find Polynomial of degree two which takes the values 

x 0 1 2 3 4 5 6 7 

y 1 2 4 7 11 16 22 29 
 

CO3 

 

SECTION – D (Applying) 

Answer any ONE Question: (1  12 = 12 Marks) 

19 From the following data find x=1945 and x=1985 

X 1941 1951 1961 1971 1981 1991 

Y 2500 2800 3200 3700 4350 5225 
 

CO3 

   

20 Evaluate  using Trapezoidal Rule, Simpson’s  and Actual integration CO4 
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 

SECTION – A  

Answer ALL the Questions: (5  1 = 5 Marks) 

1 Shortcut key for Spell Checker is 

 a) F3 b) F8 c) F7 d) F6 

CO2 

2 How to use the headers and footers in document page 

 a) Insert → Headers and Footers b) View → Headers and Footers  

 c) Design → Headers and Footers d) Review → Headers and Footers 

CO2 

  3 How to add a Table in word document 

 a) Insert → Table b) ctrl+T c) Both d) None of these 

CO2 

4 How to add two numbers in Excel using formula 

 a) =SUM(A1+B1) b) =SUM (A1:B1) c) =SUM (A1; B1) d) =SUM (A1, B1) 

CO3 

5 Select the entire row in spreadsheet  

 a) ctrl+tab b) ctrl+space c) shift+space d) shift+tab 

CO3 

 

SECTION – B 

Answer ALL the Questions: (2  2 = 4 Marks) 

6 Define Document Formatting? CO2 

7 Creating a spreadsheet for 3student’s odd semester marksheet? CO3 

 

SECTION – C 

Answer ALL the Question: (1  6 = 6 Marks) 

8 a) Creating a spreadsheet for five person’s purchase list of sports goods using formulas? CO3 

(OR)  

b) Explain various types charts with example? CO3 

 

SECTION – D 

Answer any ONE Question: (1  10 = 10 Marks) 

9 Explain about a spreadsheet about how to insert, delete, merge, add and remove (row column), 

split cells, insert (pic, chart), formatting cells? 

CO3 

10 Creating a Presentation for generating a movie concept using video merging, inserting pictures 

like a project? 

CO4 
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 

SECTION – A (Remembering) 

Answer ALL the Questions: (10  1 = 10 Marks) 

1 What does HTML stand for? 

 a) Hyper Trainer Marking Language b) Hypertext Marketing Language 

 c) Hypertext Markup Language d) Hyperlink and Text Markup Language 

CO1 

2 Which tag is used to create a hyperlink in HTML? 

 a) <link> b) <a> c) <href> d) <hyperlink> 
CO1 

3 What is the correct HTML element for inserting a line break? 

 a) <break> b) <br> c) <lb> d) <new line> 
CO1 

4 Which of the following is used to define an ordered list in HTML? 

 a) <ul> b) <ol> c) <li> d) <dl> 
CO2 

5 How can you make text bold in HTML? 

 a) <strong> b) <b> c) both d) <bold> 
CO2 

6 Which tag is used to insert an image in HTML?  

 a) <image> b) <img> c) <src> d) <picture> 
CO2 

7 What is the correct way to add a background color in HTML? 

 a) <body bg= “yellow”>  b) <background>yellow</background-color: yellow;”> 

 c) <body style=” background-color: yellow;”> d) <bgcolor>yellow</bgcolor> 

CO3 

8 Which tag is used to create a table in HTML? 

 a) <table> b) <tbl> c) <tr> d) <td> 
CO3 

9 What is the purpose of the <head> tag in HTML? 

 a) It contains the main content of the webpage b) It contains metadata, title, and links to stylesheets. 

 c) It defines the footer of the webpage. d) It is used to display headings 

CO3 

10 Which tag is used to create a dropdown list in HTML? 

 a) <dropdown> b) <select> c) <list> d) <option> 
CO3 

 

SECTION – B (Remembering) 

Answer any FIVE Questions: (5  2 = 10 Marks) 

11 What is HTML? CO1 
12 What is the purpose of the <head> tag in HTML? CO1 
13 What is the difference between <div> and <span> tags in HTML? CO2 
14 What is an attribute in HTML? Give an example CO2 
15 What is the difference between the <ul> and <ol> tags in HTML? CO3 

 

SECTION – C (Understanding) 

Answer any THREE Questions: (3  6 = 18 Marks) 

16 a) Explain Internet and web browsers?                                   (OR) 

b) Explain using Web basics in HTML? 
CO1 

17 a) Create a HTML program for using Font styles?                 (OR) 

b) Create a HTML program using paragraph and break tag. 

CO2 

18 a) Create a HTML program using Ordered List.                     (OR) 

b) Explain in detail about Unordered List. 

CO3 

 

SECTION – D (Applying) 

Answer any ONE Question: (1  12 = 12 Marks) 

19 Explain any 10 basic tag and their functions? With suitable example. CO1 
20 Create a program using Header and Title tag. CO2 
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 

SECTION – A (Remembering) 

Answer ALL the Questions: (10  1 = 10 Marks) 

1 Which keyword is used to inherit a class in Java? 

 a) implements b) extends c) inherits d) super 

CO2 

2 Which access modifier allows a member to be accessed from any other class? 

 a) private b) protected c) default d) public 

CO2 

3 Which keyword is used to define an interface in Java? 

 a) interface b) abstract c) implements d) extends 

CO3 

4 What is the default package in Java? 

 a) java.lang b) java.util c) The unnamed package d) java.base 

CO3 

5 Which package contains the basic classes for input/output (I/O) in Java? 

 a) java.io b) java.net c) java.util d) java.awt 

CO3 

6 Which package contains classes for networking functionality in Java? 

 a) java.awt b) java.net c) java.io d) java.sql 

CO3 

7 The java.math package is primarily used for which purpose? 

 a) File handling  b) Network communication 

 c) Mathematical operations d) Database connectivity 

CO3 

8 Which of the following methods from the System class is used to copy data from one location to 

another in memory? 

 a) System.arraycopy() b) System.clone() c) System.copy() d) System.transfer() 

CO3 

9 What is a thread in Java? 

 a) A unit of memory  b) A unit of CPU execution 

 c) A unit of network communication d) A class for file handling 

CO4 

10 Which method is used to pause a thread's execution for a specified amount of time in Java? 

 a) wait() b) sleep() c) pause() d) block() 

CO4 

SECTION – B (Remembering) 

Answer ALL the Questions: (5  2 = 10 Marks) 

11 Define Class. CO2 
12  Define Interface. CO3 
13 Write the syntax of Interface. CO3 
14 What is Package? CO3 

15 Define Thread. CO4 
SECTION – C (Understanding)  

Answer ALL the Questions: (3  6 = 18 Marks) 

16 a) Explain about the Inheritance and its types.                                          (OR) CO2 
 b) Write a simple java program using class, object and Methods. CO2 

17 a) Explain about the Interface with example.                                            (OR) CO3 
 b) Discuss about the implementation of Interface. CO3 

18 a) Write about the types of package.                                                         (OR) CO3 
 b) How to create the package with example. CO3 

SECTION – D (Applying) 

Answer any ONE Question: (1  12 = 12 Marks) 

19 Explain about the Package with example CO3 

20 Briefly explain the Life cycle of Thread. CO4 
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SECTION – A (Remembering) 

Answer ALL the Questions: (10  1 = 10 Marks) 

1 Graphical optimal value for Z can be obtained from 

 a) Corner points of feasible region b) corner points of the solution region 

 c) Both a and c  d) none of the above 

CO2 

2 Feasible solution satisfies ______________ 

 a) Only constraints  b) only non-negative restriction 

 c) [a] and [b] both  d) [a],[b] and Optimum solution 

CO2 

3 In the simplex method for solving of LPP number of variables can be ______________. 

 a) Not more than three b) at least three c) at least two d) none of them 

CO3 

4 For the constraint of greater than equal to type we make use of ______________ variable. 

 a) slack b) surplus c) artificial d) basic 

CO3 

5 In linear programming, most popular non-graphical procedure is classified as 

 a) linear procedure b) non-graphical procedure c) graphical procedure d) simplex method 

CO3 

6 Linear programming involves more than two variables can be solved by 

 a) simplex method b) Big-M method c) both d) graphical Method 

CO3 

7 Which of the following is a valid objective function for a linear programming problem? 

 a) Max = 5xy b) Min= 4x + 3y + 2z c) Max=5x 2 + 6y 2 d) Min (x1 + x2)/x 3 

CO3 

8 If an artificial variable is present in the basic variable column of optimal simplex table, Then the 

solution is 

 a) unbounded b) infeasible c) optimal d) None of these 

CO3 

9 The initial solution to a transportation problem can be generated in any manner, so long as 

 a) it minimizes cost  b) all supply and demand are satisfied 

 c) degeneracy does not exist d) all cells are filled 

CO4 

10 The maximization or minimization of a quantity is the 

 a) goal of management science. b) decision for decision analysis. 

 c) constraint of operations research. d) objective of linear programming. 

CO4 

 



 

 

SECTION – B (Remembering) 

Answer ALL the Questions: (5  2 = 10 Marks) 

11 Write about LPP   CO2 

12 Define Surplus variable with Example CO3 

13 Define Slack variable with Example CO3 

14 What you mean by unbounded solution in graphical method   CO3 

15 Define Transportation Problem  CO4 

 

SECTION – C (Understanding)  

Answer ALL the Questions: (3  6 = 18 Marks) 

16 a) Write Procedure to solve the graphical method  CO1 

 (OR)  

 b) Apply graphical method for the following LPP 

  

CO1 

17 a) Write steps to solve Simplex Method  CO3 

 (OR)  

 b) Solve the following the LPP using Simplex method  

 

CO3 

18 a) write the procedure on standard form and Express the following LPP in Standard form 

  

CO3 

 (OR)  

 b) Write the procedure of Canonical for and   Express the following LPP in Canonical form 

 

CO3 

 

SECTION – D (Applying) 

Answer any ONE Question: (1  12 = 12 Marks) 

19 Solve the following the LPP using Simplex method 

 

CO3 

20 Write the procedure to IBFS of North-West Corner Rule and find IBFS of Transportation Problem 

North-West Corner Rule  

 D E F G AVAILABLE 

A 11 13 17 14 250 

B 16 18 14 10 300 

C 21 24 13 10 400 

REQUIREMENT 200 225 275 250  
 

CO4 
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 

SECTION – A 

Answer ALL the Questions: (5  1 = 5 Marks) 

1 The value of (256)5/4   is: 

 a) 512 b) 984 c) 1024 d) 1032 

CO2 

2 The ratio 5:4 expressed as a percent equals: 

 a) 12.5% b) 40% c) 80% d) 125% 

CO2 

3 A does a work in 10 days and B does the same work in 15 days. In how many days they together will do the 

same work? 

 a) 5 days b) 6 days c) 8 days d) 9 days 

CO3 

4 A train moves with a speed of 106 kmph. Its speed in meters per second is: 

 a) 10.8 b) 18 c) 30 d) 38.8 

CO3 

5 At the rate of 8*1/2% p.a. simple interest, a sum of Rs. 4800 will earn how much interest in 2 years 3 months? 

 a) Rs. 796 b) Rs. 816 c) Rs. 918 d) Rs. 956 

CO3 

SECTION – B 

Answer ALL the Questions: (2  2 = 4 Marks) 

6 A, B and C started a business by investing Rs. 1,20,000, Rs. 1,35,000 and Rs.1,50,000 respectively. Find the 

share of each, out of an annual profit of Rs. 56,700. 

CO2 

7 A train 100 m long is running at the speed of 30 km/hr. Find the time taken by it to pass a man standing near 

the railway line. 

CO3 

SECTION – C 

Answer ALL the Question: (1  6 = 6 Marks) 

8 a)   i) The population of a town is 1,76,000. If it increases at the rate of 5% per annum, what will be its 

          population 2years hence? What was it 2 years ago? 

     ii) The value of a machine depreciates at the rate of 10% per annum. If its present value is Rs.1,62,000, 

          what will be its worth after 2 years? What was the value of the machine 2 years ago 

                                                                               (OR) 

b) Find compound interest on Rs.8000 at 15% per annum for 2 years 4 months, compounded annually? 

CO3 

SECTION – D 

Answer any ONE Question: (1  10 = 10 Marks) 

9 Find the Slant height, volume, curved surface area and the whole surface area of a cone of radius 21cm and 

height 28cm? 

CO2 

10 a) An article is sold at a certain price. By selling it at 2/3 of that price one loses 10%. Find the gain  

    percent at original price? 

b) A dealer sold three-fourth of his articles at a gain of 20% and the remaining at cost price. Find the  

    gain earned by him in the whole transaction? 

CO3 
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 

SECTION – A (Remembering) 

Answer ALL the Questions: (10  1 = 10 Marks) 

1 World population day is celebrated on 

 a) March 21 b) April 22 c) July 11 d) September 28 

CO1 

2 Eco Mark of Country is  

 a) Earthern mug b) Earthern pitcher c) Earthern saucer d) Earthern lamp 

CO1 

3 September 16-23 is observed as 

 a) Ozone week b) wildlife week c) Biodiversity week d) Disaster reduction week 
CO1 

4 During photosynthesis trees produce 

 a) oxygen b) CO2 c) N2 d) CO 
CO2 

5 Deforestration rate alarming 

 a) Temperature countries b) Tropical countries c) polar region d) None of the above 
CO2 

6 Nuclear Energy can be generated by  

 a) Nuclear Fusion b) Nuclear Fission c) both a and b d) none 
CO2 

7 Gross primary product is highest in  

 a) open oceans b) Grass lands c) Wet Trophical forest d) Agroecosystem 
CO3 

8 The term eco system coined by 

 a) Transley b) Charles Babbage c) Charles Tarvin d) Ada 

CO3 

9 The organisms which feed on dead organisms, wastes of living organisms are called 

 a) chemotrophes b) carnivores c) Detrivores d) Decomposer 

CO3 

10 Estuaries have the following characteristics 

 a) Fresh and Salt water b) Rich Bio Diversity c) Forest d) high Productivity 

CO3 

 

SECTION – B (Remembering) 

Answer ALL the Questions: (5  2 = 10 Marks) 

11 Define Environment CO1 

12 Expand     i) IUCN                 ii) UNEP CO1 
13 Name any four renewable energies CO2 
14 Name any four non-renewable energies CO2 
15 Define Ecology CO3 

 

SECTION – C (Understanding) 

Answer ALL the Questions: (3  6 = 18 Marks) 

16 a) What is the scope of Environmental Studies.               (OR) CO1 

 b) Write short notes about Nature.  CO1 
17 a) Discuss about Major causes of deforestation.              (OR) CO2 
 b) Write about Biotic and Abiotic with example.   CO2 

18 a) Discuss about consumer and its types.                         (OR) CO3 
 b) Discuss about types of food chain.   CO3 

 

SECTION – D (Applying) 

Answer any ONE Question: (1  12 = 12 Marks) 

19 Write about Benefits of Environmental Education CO1 
20 Discuss about Renewable alternate energy resources CO2 
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 

SECTION – A (Remembering) 

Answer ALL the Questions: (10  1 = 10 Marks) 

1 Inside which HTML element do we put the JavaScript? 

 a) <scripting> b) <script> c) <javascript> d) <js> 

CO2 

2 What is the correct syntax for referring to an external script called "xxx.js"? 

 a) <script name="xxx.js"> b) <script src="xxx.js"> c) <script href="xxx.js"> d) <script type="xxx.js"> 

CO2 

3 How do you write "Hello World" in an alert box? 

 a) alertBox("Hello World"); b) msg("Hello World"); c) alert("Hello World"); d) msgBox("Hello World"); 

CO2 

4 Moving from one website to another is called ______________ 

 a) transferring b) shifting c) browsing d) loading 

CO2 

5 How do you declare a JavaScript variable? 

 a) var carName; b) variable carName; c) v carName; d) var acar name; 

CO3 

6 Which operator is used to assign a value to a variable? 

 a) *  b) = c) x d) – 

CO3 

7 Who is making the Web standards? 

 a) The World Wide Web Consortium      b) Google c) Mozilla d) Microsoft 

CO3 

8 What does "JS" stand for in JavaScript?  

 a) Java Standard b) JavaScript c) Just Script d) Java Syntax 

CO3 

9 How do you declare a multi-line comment in JavaScript?  

 a) // comment b) /* comment */ c) -- comment d) ' comment ' 

CO3 

10 Who is the father of PHP? 

 a) Rasmus Lerdorf b) Willam Makepiece c) Drek Kolkevi d) List Barely 

CO4 

 

SECTION – B (Remembering) 

Answer any FIVE Questions: (5  2 = 10 Marks) 

11 Define Java Script CO2 

12 List out the advantages of Java Script CO2 

13 Difference between Java and Java Script CO2 

14 Write about the DOM CO3 

15 Define Event Handling CO3 

16 Write about Cookies CO3 

17 Define PHP. CO4 

 

SECTION – C (Understanding) 

Answer any THREE Questions: (3  6 = 18 Marks) 

18 Explain about the JavaScript Syntax with example CO2 

19 Explain about the Datatype, Variable and Function in JavaScript CO3 

20 Illustrate the concept of Event Handling with example  CO3 

21 Demonstrate the DOM in JavaScript CO3 

22 Write notes on Cookies in JavaScript CO3 

 

SECTION – D (Applying) 

Answer any ONE Question: (1  12 = 12 Marks) 

23 Illustrate the Browser and Form Object in Java Script CO3 

24 Discuss about the Basic of PHP, Datatypes and Variables with example CO4 
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 

SECTION – A (Remembering) 

Answer ALL the Questions: (10  1 = 10 Marks) 

1 Select the most appropriate situation for that a blind search can be used.  

 a) Real-life situation b) Small Search Space c) Complex game d) All of the above 

CO2 

2 The maximum depth to which the alpha-beta pruning can be applied. 

 a) Eight states b) Six states c) Ten states d) Any depth 
CO2 

3 Which process makes two different Logical expressions look identical? 

 a) Unification b) Lifting c) Inference Process d) Decomposition 
CO2 

4 An Algorithm is said as Complete algorithm if_______________ 

 a) It ends with a solution  b) It begins with a solution  

 c) It does not end with a solution. d) It contains a loop 

CO2 

5 Which term describes the common-sense of the judgmental part of problem-solving? 

 a) Values-based b) Critical c) Analytical d) Heuristic 
CO3 

6 Web Crawler is a /an ________________________  

 a) Intelligent goal-based agent b) Problem-solving agent  

 c) Simple reflex agent  d) Model based agent 

CO3 

7 Backtracking is based on ____________ 

 a) Last in first out  b) First in first out 

 c) Recursion  d) Both Last in first out & Recursion 

CO3 

8 How many possible sources of complexity are there in forward chaining? 

 a) 1 b) 2 c) 3 d) 4 
CO3 

9 PROLOG is an AI programming language which solves problems with a form 

of symbolic logic known as predicate calculus.  

 a) Alain Colmerauer b) Niklaus Wirth c) Seymour Papert d) John McCarthy 

CO3 

10 Reinforcement learning is a ________________ 

 a) Prediction-based b) feedback based c) History results-based d) web based 

CO4 

SECTION – B (Remembering) 

Answer any FIVE Questions: (5  2 = 10 Marks) 

11 Give the operations of knowledge based agents? CO2 
12 List the parts of knowledge based agents? CO2 
13 Give the approaches to build a knowledge based agent? CO2 
14 List the kinds of knowledge to be represented in a KBA? CO3 
15 Define the term knowledgebase? CO3 
16 List the components in the AI knowledge cycle? CO3 
17 Distinguish declarative knowledge and procedural knowledge? CO4 

SECTION – C (Understanding)  

Answer any THREE Questions: (3  6 = 18 Marks) 

18 Discuss about the characteristics of alpha-beta pruning? CO2 
19 Brief a note on various knowledge levels in a KBA? CO3 
20 Write a brief note on logical representation of knowledge representation?  CO3 
21 Brief a note on any one approach for knowledge representation? CO3 
22 Summarize on the requirements of a good knowledge representation system? CO3 

SECTION – D (Applying) 

Answer any ONE Question: (1  12 = 12 Marks) 

23 Elaborate on the First Order Logic knowledge representation and its components? CO3 
24 Explain in detail Learning and forms of learning? CO4 
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 

SECTION – A  

Answer ALL the Questions: (5  1 = 5 Marks) 

1 ____________________ refers to the relationship between humans and machines 

 a) Machine-Man interaction b) Man-Machine interaction  

 c) Humanoid interaction d) Machine interaction 

CO2 

2 Prolonged use of machines can cause which type of injuries 

 a) strain injuries b) programming injuries c) hardware injuries d) Repetitive strain injuries 

CO2 

3 What type of technology is used to designing and developing human priorities? 

 a) Human centered technology b) User centered technology  

 c) Application oriented technology d) Designing and Developing technology 

CO2 

4 Why countries are investing in cyber defense and offensive capabilities 

 a) National securities b) cyber warfare c) both d) None of these 

CO3 

5 Sustainable sourcing of raw materials in social and ethical audit for which purpose 

 a) Environmental Responsibilities b) Global welfare 

 c) both  d) None of these 

CO3 

 

SECTION – B 

Answer any TWO Questions: (2  2 = 4 Marks) 

6 What are the merits and demerits of Problems of technology transfer? CO2 

7 Define Technology. CO2 

8 List out the types of Politics and Technology CO3 

9 What do you know about Social and Ethical audit of industrial organization? CO3 

 

SECTION – C 

Answer any ONE Question: (1  6 = 6 Marks) 

10 Explain the Problems of Man-Machine interaction CO2 

11  What is Politics and Technology and its various applications? CO2 

 

SECTION – D 

Answer any ONE Question: (1  10 = 10 Marks) 

12 Explain in detail about Problems of Technology transfer? CO2 

13 Explain Impact of assembly line, automation of technology and developing nations CO3 


